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Introduction

SpeechEd is a utility for teaching the JSDSPCH speech system how to pronounce words properly.    The 
speech system knows how to pronounce most words in the English language but occasionally you may 
come across words that do not follow the normal rules and that it doesn't know about.    These are usually 
place names or peoples names.

Using SpeechEd you can teach the speech system how it should pronounce the word.    You can do this in
two ways.    Either you can give it a different spelling which follows the standard rules better e.g. use 
Gloster for the word Gloucester.    Or, for more advanced users, if you are familiar with the international 
phonetic alphabet you can describe the pronunciation using phonetics.

There are two different screens, depending upon which system you are using.    The 'simple editor' and 
the 'phonetics editor'.

Any changes you make are automatically added to the speech systems pronunciation dictionary.    If you 
later find that the pronunciation is not as you would wish you can come back and amend the 
pronunciation.



Teaching New Pronunciations 

You can teach the speech system new pronunciations either by giving SpeechEd a different spelling of 
the word which follows the standard English pronunciation rules better or by using the International 
Phonetic Alphabet to describe the pronunciation accurately.

Here, we'll describe the simple use using the 'sounds like' technique.    For information on using phonetics
see the Teaching using phonetics topic

When using the 'simple editor' the screen looks like this:

You type in the word you want to change the pronunciation of in the 'Word' box.    You can listen to the 

current pronunciation using the ear  button next to it.

Then, type in an alternative spelling which describes the pronunciation better into the 'Sounds like' box.    
You can listen to this pronunciation using the ear button next to that box.    The 'sounds like' word does not
need to be a properly spelt word.    You may need to try a few different spellings until you get the correct 
sound.

When you are happy with your new pronunciation, click on the Add button.    The word will be transferred 
to the list on the right hand side of the screen marked 'Your word list'.    This word list contains all the 
words that have had their pronunciation changed.

To change the pronunciation of a word you have already taught it, click on the word to change in the word 
list.    It will appear in the 'word' box.    You can then type in a new 'Sounds like' word.    You will need to 
click on the Add button again to make your change be remembered.

You can remove a word from the word list by selecting it and then clicking on the Remove button.

Any word you teach the speech system is also used for appropriate plurals and derived words.    For 
example if you were teaching it the word "Whisk", the pronunciation would also apply to Whisks, Whisker, 
Whiskers, Whisked and Whiskable (if there is such a word).    Sometimes this is not what you want.    For 
example the word Suite (pronounced sweet).    Suites (sweets) is fine but suited (sooted) and suitable are 
not.    In such circumstances you can use the Special Cases button to say which words it applies to.    You 
also use Special cases if the pronunciation only applies when the word is in capitals e.g. IT rather than it.  
For details on these and other special cases see the Special cases section.

When you exit from SpeechEd it asks you if you want to keep the changes you have made.    These 



changes then apply to any program on your computer that uses the JSDSPCH speech system,



Teaching using phonetics

In addition to teach the speech system new pronunciations using the 'sounds like' system (see Teaching 
new pronounciations), you can teach it using a phonetic alphabet.

To use phonetics you must select Use phonetics editor from the View menu.    The screen will then look 
like this.

In addition to the simple editor screen there are two green boxes for phonetic text and buttons containing 
phonetic symbols.

If you type a word into the 'Word' box, you will see phonetics appear in the 'phonetic spelling' and 'New 
phonetics' boxes.    These are a phonetic representation of the word type, according to the rules the 
speech system already knows.

You can then edit the 'New phonetics' directly or use the 'Sounds like' box as with the simple editor.    If 
you type a word in the 'Sounds like box' the phonetics in the 'New phonetics' box will change to represent 
the 'Sounds like' word.

Clicking on a phonetic key will insert the symbol(s) into the 'New phonetics' box.    Using them you can 
build up a phonetic sound.    Clicking on the purple DEL key will delete a symbol; you can also use the 
normal delete keys on the keyboard.

The phonetic keys are divided into 4 groups.    The Red keys represent vowel sounds, the light blue 
sounds represent consonants, the dark blue buttons represent special consonants known as continuants 
or frictionless consonants, and the green buttons are used for placing stress marks or inserting pauses.    

As you move the pointer over one of the phonetic keys a label will appear near the key give a description 
of the sound it makes.    If you turn on Speak phonetic buttons in the View menu it will also speak an 
example word that uses the sound.



See Phonetic keyboard for more details about using the phonetic keys.



Phonetic Keyboard

The phonetic keys shown represent letters of the phonetic alphabet.    The Red buttons represent vowel 
sounds, the light blue sounds represent consonants, the dark blue buttons represent special consonants 
known as continuants or frictionless consonants, and the green buttons are used for placing stress marks 
or inserting pauses.

The easiest way to discover the sound is to move the pointer over the phonetic key.    A label will then 
appear giving you a description of the sound.    It gives the appropriate letter(s) in English making up the 
sound and an example word that uses the sound.

For example:    moving over the a button will give the label "a as in cat". If you turn on Speak phonetic 
buttons in the View menu it will also speak the example word that uses the sound e.g. "cat".

The easiest way of seeing how English words translate into phonetics is to type English words into the 
'Sounds like' box.    The phonetics for that word can then be viewed.

Special notes on certain phonetic symbols

 This vowel known as schwa (an upside down e symbol), is an unstressed neutral vowel.    It is the 
most common vowel in English, but does not have its own symbol in the English alphabet!    It is quite 
likely that this is the vowel to use in an unstressed position in a word to get the correct sound.

 The j button gives the sound which is generally represented in English by the y letter (as in young).

 The c button gives a sound which is not used in English.    This is the sound such as in the German 
word ich.    The x button gives the more normal English hard ch sound, or the k button gives the common 
k or hard c sound..

 These buttons, which are called linking y and linking r respectively, are weaker versions of the j 
and r phonetic sounds.    They are used internally within words, particularly when between a vowel and a 
following unstressed vowel.

Stressed Syllables

The speech dictionary not only gives the phonemes which make up an English word, but also gives the 
position of the main stressed syllable in the word.    If a word sounds wrong, it may simply be that the 
wrong syllable is being stressed.

If no stress is marked, then by default it falls on the first syllable of the word.

To change the stressed syllable, place the primary stress marker indicator (')  before vowel you wish to 
stress.    For example, Wolverhampton should have the stress on the third syllable hamp, not the first 
syllable.

In a few cases, in a multi-syllabic word, you may also need to place a secondary stress marker (.) to 
produce the correct stress pattern throughout the word.    This gives an additional weaker stress.

Note that with some words, the position of the stress varies depending on whether the word is being used
as a noun or a verb.    For example contrast, insert etc.    Compare:

Pick up a large object
He will probably object

The speech system does not do a full grammatical analysis but does attempt to make this distinction 
when reading a text passage.





Special Cases

Special cases are when the new pronunciation does not apply to all cases of the word.

These special cases apply to:
Plurals
Derived words
Capitals
Special pauses

Exclude all derived words

When you add a new pronunciation this applies to not only the word you supply, but also certain 
derivatives formed by adding suffixes.    The suffixes recognised are:

plurals:    -s, -es, 
derivatives: -ed, er, est, -ing, -ness, -able, -ably, -ability, -ation, -ship, -ly

If you select the special case Exclude all derived words then the pronunciation applies only to the word 
as typed in, and not to any of the derived words formed by adding one of the above suffixes.    This is 
used when the pronunciation would change when a suffix is added.    For example Suite and Suitable.

Include plurals only

This variation is used if the plurals for a word would be correct, but not any other derived words.    For 
example:    Suite and Suites are OK but not Suitably and Suited.

Only when in capitals

The pronunciation of some abbreviations only apply when the word is in capitals, since in such 
circumstances the letters should be pronounced singly rather than as a word.    Most obviously IT is 
different to it, but also ME and TUC may need to be pronounced differently.

Pause slightly before word

Some words require an extra pause before them to ensure that a sentence containing them is spoken 
more naturally.    The applies particularly to conjunctions such as and and but.



Toolbar

    Save pronounciations

    Cut

    Copy

    Paste



File menu commands

Revert to Saved Reverts to the pronunciation list last saved.
Save Saves the current pronunciation list.
Exit Exits SpeechEd.



Edit menu commands

Cut Cuts the current selection to the clipboard.
Copy Copies the current selection to the clipboard.
Paste Pastes text from the clipboard.



View menu commands

Use simple editor Use the simple 'sounds like' pronunciation editor.
Use phonetics editor Use the full phonetics editor.
Speak phonetic 
buttons

Speak an example word when pointer goes over phonetic button.

Help menu commands

The Help menu offers the following commands, which provide you assistance with SpeechEd: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of SpeechEd.

 Revert to Saved

If you get confused when amending the pronunciation list, or delete a word by mistake you can revert to 
the last version you saved using this command.



 Save

This command saves the current pronunciation word list on the disk.    The pronunciation list is opened 
automatically when you start up SpeechEd and you are asked if you want to save it when you exit.    Use 
the Save button to save the word list at other times.    This can be a good idea if making a lot of changes.



Exit

This button takes you out of SpeechEd back to Windows.    You will be asked if you want to save changes
made to the pronunciation word list.



 Cut

Use this command to remove the currently selected data and put it on the clipboard.    This command is 
unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.



 Copy

Use this command to copy selected data onto the clipboard.

Copying data to the clipboard replaces the contents previously stored there.



 Paste

Use this command to insert a copy of the clipboard contents at the insertion point.



Use simple editor

This command sets SpeechEd into its simple pronunciation editing mode.    With the simple editor you 
change the pronunciation of words using a 'sounds like' system.    See Teaching new pronounciations for 
more information on using the simple editor.

If you want to use the full phonetics editor select Use phonetics editor from the View menu.



Use phonetics editor

This command sets SpeechEd into its full phonetics editing mode.    With the phonetics editor you can 
change the pronunciation of words using a 'Sounds like' system or by defining the pronunciation using the
phonetic alphabet.    See Teaching using phonetics topic for more information on using the phonetics 
editor.



 Speak phonetic buttons

When using the phonetics editor, you can choose whether to have an example word spoken when you 
move the pointer over one of the phonetic keys.



Index (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using SpeechEd and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help

Use this command for instructions about using Help.



About Speech Editor

Use this command to display the copyright notice and version number of your copy of SpeechEd.



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button

{bmc 



} Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the SpeechEd window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the    window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.




